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Compatibility 
 
Version 2.5 of Informatik Image Driver is supported by Windows NT 4.0, 2000 and XP. Please 
consult support@hsm.ch   
 
Separate versions are available for Windows 95/98/Me, Server  2003  (including remote server, 
sharing), Windows Terminal Server (WTS) and Citrix.  
 

Introduction 
 
The Informatik Image Driver creates TIFF and PDF (and JPEG) files from virtually any Windows 
document.  Simply open the document (for example open a Word file in Microsoft Word), choose 
Print from the File menu, select the Informatik Image Driver 2.5 as the printer, press the OK 
button, in the Informatik Image Driver dialog window specify the output folder, file name and other 
settings, and press the OK button.  This is, of course, somewhat of an over-simplification; there 
are many features and options as explained in this user guide.  For advanced and unattended 
use, many settings can be assigned programmatically. 
 
This help document covers the version of the Informatik Image Driver for Windows NT 4.0, 2000, 
and XP.  Separate versions are available for Windows  Windows 95/98/Me.  An optional add-on is 
available for various other graphics formats, text annotations, watermarks, etc.  Also available are 
special printer drivers, text extraction drivers (TextLog) and custom drivers.   
 
Before you use the program please read the licensing terms and conditions in License, 
Warranties, Disclaimer section below.  By using this program you agree to all the terms and 
conditions of the license. 
 
 
Demo Version 
 
You may use this demo version only for the purpose of evaluating the program.  The demo 
version creates valid TIFF and PDF output; the output files are crippled.  The upper left corner is 
blank.This limitation is to avoid productive use of the demo version.   

Versions 
 
Informatik Image Driver is available in only one version, mainly for compatibility with NT 4.0 PC’s 
or workstations. 
  
This version can be installed and run on a PC or workstation.  The share and WTS capabilities are 
enabled. Output files can be saved to any folder that is accessible to the user, locally or on 
networked drives.   
A single-seat software license is required for each PC or workstation on which the driver is 
installed.   
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The driver can also be used for comprehensive network use.  It supports remote, shared, 
multithread processing and is fully compatible for Windows Terminal Server (Version NT).  The 
driver is installed on the server and can be shared.   The output files can be saved to any local 
folders of the server, and to folders for which the logged-in user has WRITE permission.   
 
The appropriate server/multi-user software license must be purchased.  Installation of the driver 
on Citrix requires a special license. 
 

 

Installation 
 

1. If you are installing from a zip file (a compressed download file with a .zip extension), unzip 
the zip file first into a separate folder (we recommend that you create and use the 
c:\imagedriver folder). 

 
2. Before you install the Informatik Image Driver, check if you already have a previous version 

of the driver installed on your system.  If you already have the Informatik Image Driver 
installed (licensed or demo, current or previous versions) you must first un-install the driver, 
then restart Windows.  For a clean un-install of the driver, please use the REMPRRN 
remprn.exe driver uninstall utility.  This utility is included with all our driver distributions.  If 
you do not have the REMPRN utility, please download it from www.Informatik.com/driver. 

 
3. In the Windows Explorer double-click on  installer.exe file and the driver will install itself in a 

matter of a few seconds.  Follow the prompts. 
 
4. A message will appear asking whether you want to make this driver as your default printer.  

Choose Yes or No. 
 

5. A message on the Installer window will indicate when the setup is completed. 
 

6. Restart Windows. 
 

7. Check and make sure that the Informatik Image Driver now appears as an icon in the 
Printers window in the Control Panel.  Click on the Start button (lower left corner of the 
screen); choose Control Panel; choose Faxes and Printers.  Informatik Image Driver is a 
DRIVER and you will not find it in the Start Menu as an icon with other applications.  The 
driver works like a printer and operates via a document’s native program (for example 
Microsoft Word, Excel, or your own printing application).  

 
In the unlikely event that you need special settings, (special output formats, resolutions, 
etc.) you need to enter your preferences in the Printer Control.  Generally, no special 
entries are required and you are urged not to change the defaults until you have used the 
driver in standard mode and are familiar with its working and capabilities.  This manual will 
explain how you can specify default entries in the Printer Control Panel. 
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Tutorial 
 
This tutorial will create a multi-page TIFF file from any Windows document. 
 

1. Open the document that you want to convert into a single or multi-page TIFF.  For example, 
to open a Word document, launch Microsoft Word and open the document file from the File 
menu. 
 

2. Choose “Print” from the document’s File menu.  The application’s Print dialog is displayed.   
 

3. If you didn’t specify the driver as the default printer during setup, choose “Informatik Image 
Driver 2.5” as your printer.  

 
4. (If needed, you can click on the Properties (Preferences) button and specify settings for 

output graphics format and resolution; see Printer Control Panel below for details.  For this 
tutorial don’t make any changes to the properties.) 

 
5. Click on OK. 
 
6. If you are using the Demo version, the output file will be crippled (blank upper left corner).  

Click on “OK” to continue.  
 

7. The Informatik Image Driver dialog is displayed. 
  

8. In the Output Folder, type in or change the full directory path of where you want to create 
your TIFF file  (e.g. c:\documents\accounting), or better, click on the Browse button, and 
select the folder.  Do not include the file name in the Output Folder field, and do not add an 
ending back-slash( \).  This entry is normally defaulted from the previous print request.    
 

9. In the Output Filename textbox, type in or change the file name for your TIFF file, or click 
on the Browse button and select the file. If you use the driver for the first time, the file name 
is defaulted to a generic file name.  Simply overwrite the defaulted file name to a name of 
your choice. 
 

10. There are several other features and options and you may experiment with them.  They are 
explained in the Informatik Image Printer Dialog and Printer Preferences section below. 

 
11. Click OK.  The TIFF file will be created almost instantly.  You can check the progress of the 

file conversion in the Windows task bar at the bottom of the screen. 
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Printer Control Panel 
 
(Also called Informatik Image Driver Printing Preferences, or Informatik Image Driver Document 
Properties)  
 
Certain special settings, like output graphics format and resolution, need to be selected in the 
Printer Control Panel. 
 
The Printer Control Panel is accessed either from the Print window or via the Start menu (Start 
button at lower left corner of the screen).   
 
a) Open the Printer Control Panel via the Print window: 
 

When you select Print from the File menu, the Print window appears.  Select the Informatik 
Image Driver 2.5 as the printer.  Most Print windows include a Property button (sometimes 
called Preferences, etc).  Click on the Property button and the Informatik Image Driver 
Document Properties window will open (see next section below).   
 
Please note that graphics format and resolution selections made via the Print window 
persist for the life of the source file’s application (for example Microsoft Word).  When you 
re-launch the source file’s application, the settings revert back to the defaults originally 
specified in the Printer Control Panel via the Start button (see next paragraph). 

 
b) Open Printer Control Panel via the Start button: 
 

Click on the Start button (lower left corner of the screen) and select the Control Panel.  In 
the Control Panel, double-click on Printers (Printers and Faxes).  Among the list of printers 
you will find Informatik Image Driver.  Right-click on Informatik Image Driver and select 
Printing Preferences.  Don’t select Properties!. The Informatik Image Driver Printing 
Preferences window appears (see next section below).   
 
Please note that graphics format and resolution selections made via the Print window (see 
paragraph above) persist for the life of the source file’s application (for example Microsoft 
Word).  When you re-launch the source file’s application, the settings revert back to the 
defaults specified in the Control Panel via the Start button. 

 
 
Informatik Image Driver Printing Preferences window: 
 
Now you are in the Printing Preferences window.  There are four (4) tabs: 
 

• Layout 
• Paper/Quality 
• Print Output Settings 
• About 

 
 
Click on the Layout tab or the  Paper/Quality tab, then immediately press the Advanced button. 
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All other entries in the Layout or Paper/Quality windows are irrelevant to the use of the Informatik 
Image Driver and should be ignored.  All setup entries relating to output graphics formats, TIFF 
compression, Resolution and Color depth are specified via the Advanced button.   
 
Do not use any options in the Layout section; these settings are irrelevant to the use of Informatik 
Image Driver.  For Orientation, please see section below. 
 
Do not use any options in the Paper/Quality tab section; these settings are irrelevant to the use 
of Informatik Image Driver.  For Color depth, please see section below. 
 
The Print Output Settings tab displays the Document Properties or Printing Preferences window 
that contains settings for output file names, handling options and preferences.  You will rarely use 
this window because the same functions are contained in the Informatik Image Driver Dialog that 
is always displayed when you request a print (unless the Hide option is selected).  For more 
information see the Informatik Image Driver Dialog and Printing Preference section below. 
 
The About tab displays important information about the software license.  
 
 
In the Layout window or Paper/Quality window, always click on the Advanced button.  When you 
click on the Advanced button the Advanced Options window will appear. 
 
 
Advanced Options (click on Advanced button in Layout tab or Paper/Quality tab) 
 
The options are: 
 

• Paper/Output 
• Graphic 
• Document Options 
 

 
Paper/Output: 
 

Paper Size:  Generally you should not use this option.  The paper size is controlled by the 
settings in the source document’s application (for example, in MS Word, it is specified in 
the File | Page Setup).  The paper size specified in the Advanced Preferences is used only 
if the source document does not have a paper size specification.  The paper size specified 
in the source file application will always overwrite any paper size settings in the Informatik 
Image Driver. 
 
Please see Paper Size section below for instructions on creating your own custom size. 

 
Graphic: 
 

• Resolution:  Select between 72, 100, 200, 300, 400 and 600.  The default is 300.  For other 
resolutions please see Customization section. 

 
• Scaling:  (Do not use, leave it at 100%) 
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Document Options: 
 

• Format:  The Format specifies the graphics format of the output file (TIFF or JPEG, 
compression methods).  For more information on graphics formats, please read the 
Graphics Format section. 

 
• Halftone Color Adjustment: (Do not use) 

 

Informatik Image Driver Dialog and Printer Preferences 
 
When you Press the OK button in the Print window (File | Print) the Informatik Image Driver dialog 
is displayed.  This dialog will not be displayed if you previously checked the ‘Hide this Dialog’ 
checkbox; if the dialog is hidden you should un-check the Hide Print Dialog checkbox in the 
Printer Control Panel, Print Output Settings tab (see Printer Control section). 
 
The Informatik Image Driver dialog has the following settings and options: 
 
Output Mode 
 

• Document 
• Append 
• Serialization 

 
Document Mode creates multi-page TIFF files.  For example, if your source file is a 10-page 
document, the driver will create a 10-page multi-page TIFF file (one single file with 10 pages). 
 
Append Mode will cause the output file to be appended to an existing file.  If you process a 5 -
page source file and save it to a TIFF file that already has 3 pages, the driver will add the 5 new 
pages to the existing TIFF file, so that the new file will be a TIFF file consisting of 8 pages.  If the 
specified output file name does not already exist, Append mode behaves like Document mode.  
Please note:  Append only to TIFF files created with the Informatik Image Driver (certain standard 
TIFF files created with other software may be appended to, but verify the result and always make 
sure that you have backed up the original files). This option is not available when in PDF output 
mode. 
 
Serialization Mode outputs the pages of the multi-page source file as individual files with a user 
specified prefix (Serial Prefix) followed by a numeric suffix (selected as Initial Serial Number).  
For example, a 3-page source file saved as file SAMPLE (Serial Prefix) will create three files 
called SAMPLE0001.tif, SAMPLE0002.tif, and SAMPLE0003.tif.  The number of leading zeros in 
the suffix number is specified in the ‘Select Number of Digits’ (1 to 5).   
 
If ‘Reset after each Job’ is checked, the serial number will be reset to ..001 for each print job. 
 
If the ‘Reset after each Job’ is un-checked the serialization numbering will be continuous. To 
reset the Initial Serial Number to ..001 click on the Reset…button. 
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This option is not available when in PDF output mode. 
 
 
Output Selection 
 

• Output Folder 
• Output Filename 

 
 
When you use the driver for the first time, the driver defaults to generic output names.  Click on 
the Browse buttons to select/specify the Output Folder and the Output Filename.  Your selections 
will become the default for the next print job.  If no default output folder is specified, the driver will 
use the system’s TEMP file instead.   
 
Note that the Folder Name should not have an ending back-slash (\).  If the file name does not 
have an extension, a .tif (or .pdf) extension will be added automatically.  If you must create a file 
without an extension, use a period (.) after the file base name.  You can also output the files to a 
network drive.  If you run the driver in a batch mode, the folder and file name can be specified 
programmatically in the Windows Registry.  See Windows Registry section below.  
 
In Serialization mode, the Output Filename field is used for the Prefix of the filename.  Do not use 
an extension name in the Prefix field. 
 
For auto-numbering and auto-naming see next section.  For batch processing, please review the 
Batch Processing section and Windows Registry section. 
 
 
Miscellaneous Settings 
 

• Auto-numbering of Output File 
• Use Source Document Name for Output 
• Always Overwrite 
• Hide this Dialog 
• PDF Output 

 
Some of the options are disabled if the driver is set to Append or Serialization mode. 
 
Auto-Numbering of Output File names the output files by the specified Filename Prefix 
concatenated with an auto-incrementing suffix.  For example if the Filename Prefix is SALES, the 
output files will be named SALES0001.tif, SALES0002.tif, SALES0003.tif, etc.  Each print job 
increases the serial number by 1.  This is not to be confused with Serialization.  Serialization 
serializes the pages of a multi-page file; Auto-numbering numbers the output files (and output files 
can be multi-page).  The auto-number suffix can be reset to zero by clicking on the Reset File# 
button. 
 
If a prefix is not specified, the output file name will consist of the auto-incrementing number alone, 
e.g. 0001.tif. 
 
Use Source Document Name for Output applies the source name to the output file, with a 
substituted extension name.  Some programs add the application name as a prefix.  Not all 
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applications pass the correct source file name.  In some cases extraneous text needs to be 
trimmed from the file name, manually, or by sending the output file to an add-on application for re-
naming.   If the Trim Source Name is checked, the leading string of the passed source name (up 
to the right-most encountered space in the source name) is trimmed.  This option is useful to trim 
the application name that is included with the source file name by some applications (for example 
Microsoft Word). 
 
If Always Overwrite is un-checked (default setting), the driver will alert the user if the specified 
file name already exists; if the Always Overwrite is checked, an existing file is overwritten with the 
new file without a warning. 
 
If Hide this Dialog is checked, the dialog is not displayed.  Hiding  the dialog is practical only for 
Auto-numbering of files or for batch processing.  To re-display the dialog, the Hide Print Dialog 
should be un-checked again in the Printer Control Panel, Print Output Settings tab (see Printer 
Control Panel section). 
 
If PDF Output is checked, the output will be formatted as a PDF file.  For more information, 
please see the PDF Output section below. 
 
Select Application to be Launched 
 
When you create the TIFF file, you can cause Informatik Image Driver to automatically launch 
another application, passing along the output file name as a parameter.   For example, you may 
want a viewer to display the TIFF file after it has been created, or you may want an add-on 
program for further processing, file re-naming, e-mailing or faxing.  To open the TIFF file in the 
Kodak viewer, for example, type in “c:\windows\kodakprv.exe” (but check the correct path name).  
If you add a parameter, the driver will pass both the specified parameter and the output file name 
to the application (in that order, separated by a space).  It is up to the application to parse and use 
the parameter string.  The application can be selected with the ‘Browse’ button.  In most cases a 
parameter is not required.   
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Graphics Formats 
 
This Informatik Image Driver version supports several TIFF formats, both black/white and color.  
The driver also supports colored JPEG output.  The default setting is TIFF Group 4 Single -Strip.  
The output graphics format is selected in the Printer Control Panel.  Open the Layout tab section 
of the Printer Control Panel, click on Advanced button and select the Graphic section.  For 
detailed instructions on how to access the Printer Control Panel, please read the Printer Control 
Panel section. 
 
Please note that the graphics format selection made via the Print window persist for the life of the 
source file’s application (for example Microsoft Word).  When you re-launch the source file’s 
application, the settings revert back to the defaults originally specified in the Printer Control Panel 
via the Start button. 
 
 
Available formats are: 
 

• JPEG Single-page only 
• TIFF B/W Packbits 
• TIFF 256-color Packbits 
• TIFF B/W Packbits 1-Strip 
• TIFF B/W Group 4 
• TIFF B/W Group 4 1-Strip 
• TIFF 24-bit Color Packbits 
• TIFF 4-bit Color Packbits 
• TIFF F-Class 
• TIFF F-Class Reverse-Fill 

 
The default format is TIFF B/W Group 4 1-Strip, the most commonly used TIFF format. 
 
JPEG files are in high-quality 24-bit color and available only for single-page files (multi-page 
format is not supported in JPEG).  In the Image Driver Properties dialog, specify the output file 
with a .tif extension, not a .jpg extension; the actual output file will have the .jpg extension.  To 
convert a multi-page source file to JPEG, always use ‘Serialization’ in Document Mode.  If you 
convert a multi-page source document in Document Mode, the first page will be named with the 
specified output file name; the subsequent pages will be named with a _1, _2, etc., suffix.  Please 
note that JPEG conversions are much slower than TIFF conversions.  JPEG should be used for 
photo-type images; the JPEG format is not ideal for black and white text documents (file 
conversion is very slow and the files sizes are large).  If you must create black and white text 
documents in JPEG, use a resolution of 200x200 or less. 
  
The TIFF 4-bit (16 Colors) Packbits and 8-bit (256 Colors) Packbits formats are suitable only 
for solid color images, like charts, etc.  Photographic images should be converted to either JPEG 
or TIFF 24-bit Color Packbits.  Color processing requires significantly more memory than black 
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and white processing.  If your computer does not have sufficient memory to process the colors, 
the driver will revert to black and white processing. 
 
LZW compression is now available by special request. 
 
Fax applications generally require the TIFF F-Class format.  Old fax boards may require TIFF F-
Class Reverse-Fill.  For TIFF F-Class you must use a resolution of 200x200. 
 
 Many other graphics formats and compression types can be created with the Conversion Addon.  
See Add-ons section. 
 
 

Resolution 
 
The Resolution of the output file can be 72, 100, 200, 300,400 or 600.  The default is 300.  The 
resolution is changed in the Printer Control Panel (see Printer Control Panel section).  Open the 
Layout tab section of the Printer Control Panel, click on the Advanced button and select the 
Graphic section.  For detailed instructions on how to access the Printer Control Panel, please read 
Printer Control Panel section. 
 
Please note that the resolution selection made via the Print window persists for the life of the 
source file’s application (for example Microsoft Word).  When you re-launch the source file’s 
application, the settings revert back to the defaults originally specified in the Printer Control Panel 
via the Start button. 
 
Please note that for the TIFF F-Class select resolution of 200x200, the driver internally will create 
a file with 204x196 resolution. 
 
In order to minimize the size of the output files, for black and white JPEG output files and for TIFF 
24-bit Color Uncompressed output files you should use the smallest possible resolution, 
consistent with your required output quality. 
 
For other resolutions please see Customization section. 
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Paper size / Custom Paper Size 
 
The paper size should be specified in the source document’s application (e.g. File | Page Setup 
for Microsoft Word documents).  The paper size specified in the source file application will always 
overwrite any paper size settings in the Informatik Image Driver.  If the source document does not 
allow paper size specification, then you can set the paper size in the Printer Control Panel.  
Please see Printer Control Panel section).  To emphasize, all paper size settings in the Informatik 
Image Driver Printing Preferences (Printer Control Panel) are ignored if the source document has 
its own specified paper size. 
 

To create your own custom paper size, proceed as follows: 
 

• Click on Start (bottom left corner of screen). 
• Select Control Panel | Printers (do NOT select a printer) 
• In the Printers (and Faxes) window, select File menu, then Server Properties. 
• Check ‘Create New Form’ and type in ‘New Form Name’. 
• Continue as prompted. 

 
Note again, that you must specify the paper size via the input document’s Page Setup, 
before you request the print. 

 
 
 

Orientation 
 
The paper orientation must be specified in the source document’s application (e.g. File | Page 
Setup for Microsoft Word documents).   Although the Printer Control Panel includes options for 
Orientation, these are ignored by the Informatik Image Driver. 
 
 

PDF Output 
 
By simply checking the PDF Output checkbox in the Informatik Image Driver window (or in the 
Printer Control Panel), the output file will be in the PDF format with excellent compression.  The 
PDF file has an embedded TIFF of the type and compression as specified in the printer control 
panel.  Because the PDF file has an embedded TIFF it is a ‘graphics’ file and is thus not text -
searchable. 
 
If the PDF Output checkbox is checked, the output file will be PDF regardless of the extension 
name given for the file name; the PDF file will always have a .pdf extension (except if the file 
basename is followed by a period without an extension, in which case a file without an extension 
name will be created). 
 
If the PDF Output checkbox is not checked, then a TIFF file will be created, even if the specified 
file name has a .pdf extension name. 
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Important: PDF output is possible only in Document Mode.  PDF files cannot be created in 
Append or Serialization Mode. 
 
 
 
 
 

Window Registry 
 
The default output folder name, output file name and other settings are saved in the Windows 
Registry under 
 
HKEY_CURRENT_USER Software  HSM  Generic  Settings 
 
For batch processing you can set the folder name programmatically with standard API functions.  
Only make changes to the Registry if you are familiar with it.  For utilities and source code that 
allow you to make entries in the Registry please logon to www.informatik.com/vbcode. 
 
This allows XP compatibility and the use of the API's : 
 
SetPrinterData 
GetPrinterData 
 
Warning!  Before you make changes to the registry, you must be advised that the registry is the 
backbone of Windows. Don't make changes to the registry, or you could destroy Windows or other 
programs. If you decide to make changes to the registry, you should ensure that you have a good 
back up of your computer system.  
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Job and Pages Counter 
 
The cumulative number of pages and the number of pages of the last print job are stored in the 
Windows Registry (see Windows Registry section above).  This feature is useful if you run the 
driver within an application and you need to know when a print job is completed and how many 
pages have been created.  Informatik Image Driver also creates a zero-size DONE_HSM.TIF file 
at the end of each print job.  The DONE_HSM.TIF file is saved in c:\HSM directory.  The DONE 
file is useful also for determining when a print job has been completed. 
 
 

DONE_HSM.TIF Sentinel file 
 
Informatik Image Driver creates a zero-size DONE_HSM.TIF file at the end of each print job.  The 
DONE file is useful also for determining when a print job has been completed, in conjunction, 
perhaps, with the Job and Pages Counter registry postings. 
 
When a print job is requested, the driver first deletes the DONE file; it then creates a new DONE 
file when the print job is completed.  For a multi-page file (multi-page or serialized files), the DONE 
file is created only when the last page has been saved. 
 
The location of the DONE_HSM.TIF is C:\HSM. 

Network Installations 
 
The driver can be installed on PCs, workstations and servers (including Windows Terminal 
Servers and Citrix), however, server licenses are required if the driver is shared.  Server license 
fees are $750.00 to $3,250.00, scaled according to the number of workstations/terminals; the 
minimum being $750.00 for 1 -20 workstations/terminals.  A special version is available for Citrix 
networks at a license fee of $3,250.00.  Prices are subject to change; please consult the current 
web pages or contact HSM Informatik AG or Informatik Inc. 
 
If you plan to install the driver on a server as shared printer, please ensure that you obtained the 
server version and license for the correct number of workstations/terminals.  Expert knowledge in 
server and network setup and operation is required. 
 
If you use Informatik Image Driver on a network, it is recommended, for optimum performance and 
for ease of installation and operation, that you install the driver on each workstation (a license is 
required for each workstation).  The footprint of the driver is only about 500k and it installs in about 
ten seconds.   
 
You can output the TIF files to a net drive in two ways: 
 
“M:\”  or  “L:" 
or 
\\master2k\utils 
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Batch Processing 
 
Some document types lend themselves for batch processing.  For example, MS Word documents 
can be processed in a batch mode, programmatically, using the exposed objects of Word (OLE 
Automation).  For some representative VB code please go online to www.informatik.com/vbcode.  
Batch processing can take advantage of entries in the Windows Registry and use the 
DONE_HSM.TIF sentinel file.  See also the Windows Registry and the DONE_HSM.TIF Sentinel 
sections in this manual. 
 
 

Add-ons 
 
The Conversion Add-on converts the TIFF file created by the driver to many different graphics 
formats and compression types.  It also supports text annotations, watermarks, border trimming, 
special resolutions and scales, rotations, offsets, and more. 
 
For more information about the add-on utilities please logon to 
www.informatik.com/conversionaddon.html. 
 
 

Customization 
 
If you have special requirements please contact Informatik about customizing the driver.  
Examples of customizations include substituted resolutions, substituted output formats; silent 
installations, e-mail, etc. 
 
For modifications to the  driver and customized printer drivers and custom solutions please contact 
HSM Informatik AG or Informatik Inc. at these websites: 
 
HSM Informatik AG (Switzerland) www.hsm.ch 
Informatik Inc. (USA)   www.informatik.com 
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Technical Support 
 
For technical support please visit www.informatik.com/driver/faq.html.  The web page shows the 
answers to the most often asked questions and lists telephone and e-mail contact information. 
 
 

Copyright 
 
Copyright 1996-2004 HSM Informatik AG.  All Rights Reserved. 
Distributed by Informatik Inc. (USA) - www.informatik.com 
Informatik Image Driver is a trademark of HSM Informatik AG. 
 
 

License, Warranties, Disclaimer 
 
For license fee information on of the Informatik Image Driver and related products please visit 
www.informatik.com/driver. 
 
The software is supplied AS IS without any liabilities, direct or indirect, by the developer, 
distributor or agent.  It is illegal to use the software after the trial period without obtaining a valid 
software license.  The software may only be installed on the PC and type of system for which a 
valid license has been obtained.   For a full text of the license terms and conditions see License 
Agreement below. 
 
Please read this License Agreement carefully before you install and use the software.  By 
installing and using the software you agree with the terms and conditions of this License 
Agreement.  If you do not agree with the terms and conditions you must uninstall the software. 
 
 

License Agreement 
  
This License Agreement ("Agreement") is a legal agreement between HSM Informatik AG, 
Lucerne, Switzerland ("Licensor") and you, the user ("Licensee"), and becomes effective on the 
day the Licensee installs the software.  This Agreement covers all materials associated with this 
software, including, without limitation, the downloadable files, printed and online documentation, 
and any additional supporting files and programs (herein, the "Software"). 
 
1. GRANT OF LICENSE 
Licensor hereby grants to you, and you accept, a nonexclusive license to use the Software on a 
specified number of computers/workstations owned, leased, or otherwise controlled by you for 
personal or business purposes, and only as authorized in this License Agreement.  The Software 
may not be used on other computers, nor may it be used by, or transferred to, other computers 
over a network.  Unless the Licensee purchased a server license, the Software may not be 
installed on a server, or on a PC/workstation that acts as a server.  Hosting a batch service on a 
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server, PC or workstation requires a server version.  A site license permits the installation of the 
Software on an unlimited number of PC/workstations at one site for the enterprise, including a 
server.  A special developers license allows the Software to be distributed with and for exclusive 
use with the specified single application; the Software must represent a minor part of that 
application, and the application must not be a web-based application. 
 
2. LICENSOR'S RIGHTS 
Licensee acknowledges and agrees that the Software is proprietary to Licensor and protected 
under international copyright law. Licensee further acknowledges and agrees that all right, title, 
and interests in and to the Software, including associated intellectual property rights, are and shall 
remain with Licensor. The License Agreement does not convey to Licensee an interest in or to the 
Software, but only a limited right of use that may be revoked in accordance with the terms of this 
License Agreement. 
 
3. OTHER RESTRICTIONS 
Licensee agrees to make no more than one (1) back-up copy of the Software. Licensee agrees 
not to assign, sublicense, transfer, pledge, lease, rent, or share the rights assigned under this 
License Agreement. Licensee agrees not to reverse engineer, reverse assemble, reverse compile, 
or otherwise translate the Software. 
 
4. TERM 
This License Agreement is effective when Licensee installs the Software and shall terminate only 
if the terms of this License Agreement are broken. Licensee agrees to destroy the Software upon 
termination of this License Agreement. 
 
5. NO WARRANTY; LIMITATION OF LIABILITY 
LICENSEE ACKNOWLEDGES THAT THE SOFTWARE IS PROVIDED ON AN "AS IS" BASIS 
WITHOUT WARRANTY OF ANY KIND. LICENSOR, DISTRIBUTORS OR AGENTS MAKE NO 
REPRESENTATIONS OR WARRANTIES REGARDING THE USE OR PERFORMANCE OF THE 
SOFTWARE. LICENSOR DISTRIBUTORS and AGENTS EXPRESSLY DISCLAIM THE 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
LICENSOR, DISTRIBUTOR OR AGENT SHALL HAVE NO LIABILITY TO LICENSEE OR ANY 
THIRD PARTY FOR ANY LOSS OR DAMAGE CAUSED, DIRECTLY OR INDIRECTLY, BY THE 
SOFTWARE, INCLUDING, BUT NOT LIMITED TO, ANY INTERRUPTION OF SERVICES, LOSS 
OF BUSINESS, LOSS OF DATA OR SPECIAL, CONSEQUENTIAL OR INCIDENTAL AMAGES. 
 
6. GOVERNING LAW 
 
The legal jurisdiction of this License Agreement shall be Lucerne, Switzerland. 
 
 

HSM Informatik AG Guarantee  
for the Informatik Image Driver 
Version 2.5 Date: August 2004 
(excluding any used add-on programs) 
 
All reported errors or printing problems will be corrected within the year of guarantee under the 
following conditions: 
 

1) The error must be reproducible 
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2) The application in which the error occurs must have been released at the time of the driver 
release. 

 
Please report problems as follows: 
 

1) Description of the error 
2) Send the document 
3) The outputted TIFF file 
4) Should the error occur with a non-standard application, please send the application if 

possible. 
 
All reported errors or problems will be answered within 5 working days. We will comment if the 
error is due to 
 

1) System 
2) Application 
3) User 
4) Driver 

 
If we can confirm that the error is due to a driver bug, the error will be corrected within a suitable 
period of time. 
 

 
 
 


